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The information provided in this documentation contains general descriptions and/or 
technical characteristics of the performance of the products contained herein. This 
documentation is not intended as a substitute for and is not to be used for 
determining suitability or reliability of these products for specific user applications. It 
is the duty of any such user or integrator to perform the appropriate and complete 
risk analysis, evaluation and testing of the products with respect to the relevant 
specific application or use thereof. Neither Schneider Electric nor any of its affiliates 
or subsidiaries shall be responsible or liable for misuse of the information contained 
herein. If you have any suggestions for improvements or amendments or have found 
errors in this publication, please notify us. 

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product. For reasons of safety and to help ensure 
compliance with documented system data, only the manufacturer should perform 
repairs to components.

When devices are used for applications with technical safety requirements, the 
relevant instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware 
products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2012 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.
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PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and the installation, and has received safety 
training to recognize and avoid the hazards involved.
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About the Book
At a Glance

Document Scope

This document provides basic information and instructions for getting the Advantys 
Configuration Software set up and operating. It is intended for users that are already 
acquainted with the Advantys Configuration Tool.

Validity Note

This documentation is valid for Advantys Configuration Software 4.5 and later.

Related Documents

You can download these technical publications and other technical information from 
our website at www.schneider-electric.com.

Title of Documentation Reference Number

The Advantys STB System Planning and Installation Guide 31002947

The Advantys STB System Hardware Components Reference Guide 31002952

The Advantys STB Profibus DP Network Interface Applications 
Guide

31002957

The Advantys STB INTERBUS Network Interface Applications Guide 31004624

The Advantys STB DeviceNet Network Interface Applications Guide 31003680

The Advantys STB CANopen Network Interface Applications Guide 31003684

The Advantys STB Ethernet TCP/IP Modbus Network Interface 
Applications Guide

31003688

The Advantys STB Modbus Plus Network Interface Applications 
Guide

31004629

The Advantys STB Fipio Network Interface Applications Guide 31003692

The Advantys STB Reflex Actions Reference Guide 31004635
33004243 05/2012 7



User Comments

We welcome your comments about this document. You can reach us by e-mail at 
techcomm@schneider-electric.com.
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Enhancements of the Advantys 
Configuration Software
Introduction

This chapter focuses on those points of the Advantys Configuration Software that 
make the main difference to the Advantys Configuration Tool. On the one hand, an 
additional product family allowing a greater variety of functions is available. On the 
other hand, Islands, even if they contain modules of different product families, can 
be combined to so-called Workspaces. This allows a more complex structure of the 
production process.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

STB Product Family 10

What is a Workspace? 12

Island Structure 13
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STB Product Family

STB Family Description

The Advantys STB product family includes open fieldbus network interface modules 
(NIMs), power distribution modules, standard and special I/O modules, extension 
modules and special modules. These constitute the core Advantys STB modules. In 
addition, an STB Island can be extended to non-STB devices. These can be 
preferred modules and/or enhanced CANopen devices.

Overview of the Module Groups

The following table shows how these modules are grouped:

Advantys STB Modules

The core Advantys STB modules are designed to fulfill specific Advantys STB form 
factors and fit into the base units on the Island bus. They are auto-addressable and 
take full advantage of the Island’s communication and power distribution 
capabilities. The operating capabilities of an Island depend on the type of NIM.

The following NIMs provide different levels of operation:
basic
standard
premium

All NIMs have a built-in power supply. In addition, auxiliary power supplies are 
available. For extending and terminating Islands, end-of-segment (EOS) modules, 
beginning-of-segment (BOS) modules and a termination plate must be used.

Module Group Description

Networking fieldbus network interface modules

Power auxiliary power supply module and modules distributing field 
power to I/O modules

Digital Input 24 VDC and 115/230 VAC digital input modules

Digital Output 24 VDC and 115/230 VAC digital output modules

Analog Input analog voltage and current input modules

Analog Output analog voltage and current output modules

Special-Purpose counters, gateways, safety modules, etc.

Accessories terminators and Island bus extension modules

Preferred auto-addressable modules with non-STB form factor

Enhanced CANopen non-auto-addressing CANopen devices with enhanced parameter 
display
10 33004243 05/2012



Available Fieldbuses

There is a NIM type to support each of the following fieldbus networks:
CANopen
DeviceNet
Ethernet and Ethernet/IP
Fipio
Interbus
Modbus Plus
Profibus DP

Preferred Modules

A preferred module is a device from another Schneider Electric catalog, or 
potentially from a third-party developer, that fully complies with the Advantys STB 
Island bus protocol. Preferred modules are developed and qualified under 
agreement with Schneider Electric; they completely conform to Advantys STB 
standards and are auto-addressable.

For the most part, the Island bus handles a preferred module as it does standard 
Advantys STB I/O modules, with the following key differences:

A preferred module is not designed in the standard form factor of an Advantys 
STB module and does not fit into 1 of the standard base units. It therefore does 
not reside in an Advantys STB segment.
A preferred module requires its own power supply. It does not get logic power 
from the Island bus.

Preferred modules are configured using the Advantys Configuration Software. They 
can be placed between segments of STB I/O modules or at the end of the Island. If 
a preferred module is the last module on the Island bus, it must be terminated.

You can use preferred modules only with the following NIMs:
standard
premium

Enhanced CANopen Devices

CANopen devices are not auto-addressable on the Island bus. Therefore, they must 
be manually addressed, usually with physical switches built into the devices. They 
are configured using the Advantys Configuration Software. CANopen devices must 
be installed at the end of the Island. Termination must be provided both at the end 
of the last Advantys STB segment and at the last CANopen device.

Enhanced CANopen devices are CANopen devices with an enhanced parameter 
display and generated from the core catalog, as Advantys STB modules and 
preferred modules.

You can use CANopen devices only with the following NIMs:
standard
premium
33004243 05/2012 11



What is a Workspace?

Definition

The Workspace is a project environment in the Advantys Configuration Software. 
The Workspace is where you design a logical Island configuration. Within the 
Workspace, you can create a new configuration and download it into the physical 
Island. You can also upload configuration data from a physical Island to a logical 
Island in the Workspace.

A Workspace is saved as a file with an .aiw extension.

Islands in a Workspace

Within a Workspace, 1 or more logical Islands, up to a maximum of 10, can be 
created and managed. These Islands can belong to different product families. A 
Workspace can contain, for example, an Island consisting of STB modules and 1 
consisting of FTM modules

The configuration data associated with each Island are stored in its own .isl file 
within the Workspace.

NOTE: All Islands a Workspace may contain can be open simultaneously in the 
Island Editor.

Functionalities

The modules of the STB product family differ in their functionality from those of the 
FTB, FTM and OTB product families. Therefore, only the functionalities available for 
the modules concerned are available within an Island. Functionalities not available 
are grayed out.

Workspace Window

Islands are displayed in the Workspace window. The display differs in the following 
points from that in the Advantys Configuration Tool:

The Island Browser is replaced by the Workspace Browser, which lists all Islands 
a Workspace contains.
The Island Editor displays each of the 10 Islands that can be open simultaneously 
in a separate tab.
The Catalog Browser provides access to the modules of all product families.
The Log Window displaying the results of any operation performed by the 
software is added.
12 33004243 05/2012



Island Structure

Number of Segments

STB NIMs allow Island extensions to a greater extent than FTM NIMs do.

The following table provides an overview of the Island structures the different 
product families allow, including the extension possibilities:

STB Extension and Termination Modules

The STB family contains the following modules with special functions for extending 
Islands to further segments and terminating Islands:

STB XBE 1000 EOS and STB XBE 1100 EOS (end-of-segment) modules
STB XBE 1200 BOS and STB XBE 1300 BOS (beginning-of-segment) modules
STB XBE 2100 CANopen extension module
STB XMP 1100 termination plate

Product Family Island Structure and Extension Possibilities

FTB An FTB Island consists of exactly 1 FTB module which is a splitter box 
containing 8 connectors for connecting sensors and actuators. An 
extension is not possible.

FTM An FTM Island consists of 1 FTM network interface module and at 
least 1 FTM I/O splitter box. Each NIM is fitted with 4 connectors for 
connecting splitter boxes, which allows a star architecture that can 
consist of 4 segments. Each segment can contain up to 4 I/O splitter 
boxes.

OTB An OTB Island consists of 1 OTB network interface module. Every 
NIM has built-in inputs and outputs and accepts up to 7 I/O expansion 
modules, which are mounted on the same rail and thus form 1 
segment.

STB An STB Island must contain at least 1 STB NIM, 1 STB I/O module, a 
power distribution module and a terminator. The NIM resides in the 
primary segment which is the mandatory part of an STB Island. Up to 
6 extension segments can be added to the primary segment.
An STB Island can be extended to

STB I/O modules
preferred modules
enhanced CANopen devices
33004243 05/2012 13



Extending STB Islands to Further Segments

Which extension modules are used depends on the type of the extension:

Terminating STB Islands

The last module on the Island bus determines how the bus must be terminated:

Number of Modules

The maximum number of modules depends on the type of NIM and the user-defined 
maximum node ID. Depending on the type of extension, the maximum number of 
modules supported by an STB Island bus varies as follows:

Maximum Length of STB Island Buses

The total length of an STB Island bus, from the NIM to the last device, must not 
exceed 15 m (49.2 ft). This length includes both the sum of the lengths of all bus 
extension cables and CANopen cables connecting devices as well as the widths of 
the hardware modules themselves.

If you want to ... Then use...

extend the Island to 1 or 
more STB I/O modules

an STB EOS module at the end of the current segment and add 
an STB BOS module to begin the following segment.

extend the Island to 1 or 
more preferred modules

the STB XBE 1100 EOS module at the end of the current 
segment, add the preferred modules and then the 
STB XBE 1300 BOS module to begin the next segment.

extend the Island to 1 or 
more enhanced 
CANopen devices

the STB XBE 2100 CANopen extension module at the end of the 
current segment and add the enhanced CANopen devices. 
Note: Because enhanced CANopen devices are always the last 
devices on an Island bus, it must be terminated properly. See 
below for terminating an Island bus.

If the last module on the Island 
bus is ...

Then the Island bus is terminated using ...

an STB I/O module the STB XMP 1100 termination plate.

a preferred module the TeSys U LU9 RFL15 termination device.

an enhanced CANopen device the STB XMP 1100 termination plate following the 
STB XBE 2100 CANopen extension module at the end 
of the segment and a physical termination following the 
last enhanced CANopen device.

If the Island is extended to ... Then the Island bus maximally supports ...

Advantys STB modules 32 STB I/O modules.

preferred modules 31 preferred modules.

enhanced CANopen devices 12 enhanced CANopen devices.
14 33004243 05/2012
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Additional Functionalities
Introduction

This chapter gives an overview and a short description of the functionalities that the 
Advantys Configuration Software includes additionally to those provided by the 
Advanyts Configuration Tool.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Main Menu Entries 16

Shortcut Menu Entries 20

Module Editor 22

I/O Image 24

Resource Analysis and Reflex Editor 26
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Main Menu Entries

Introduction

The Advantys Configuration Software provides additional functions for all main 
menus and a new menu containing online functions.

File Menu

Because the Advantys Configuration Software allows a more complex structure 
(several Islands combined to a Workspace), the File menu includes options related 
to Workspaces as well as Islands. In addition, an Export function and a Bill of 
Materials function are available.

The File menu commands provided by the Advantys Configuration Software are 
described in the table below:

Command Description

New Workspace creates a new Workspace

Open Workspace opens an existing Workspace

Save Workspace saves the Workspace including all Islands

Copy Workspace To creates a copy of the Workspace with a new name, including all 
Islands associated with it

Close Workspace closes the Workspace

Add New Island creates a new Island in the Workspace

Add Existing Island adds an existing Island to the Workspace

Copy Island Contents copies the contents and settings of an existing Island into the 
Island currently open in the Island Editor

Save <active Island> saves the active Island

Copy <active Island> To saves a copy of the active Island to a new file, which is not 
added to any Workspace

Close <active Island> closes the active Island Editor

Remove <active Island> removes the active Island from the Workspace

Print prints a description of the Workspace and the selectable 
Islands and items

Print Setup changes the printer and printing options

Export <active Island> exports a list of accessories needed for the active Island in an 
appropriate file format based on the type of NIM

Bill of Materials exports a description of the active Island in CSV format 
including comments and alternatives if applicable

Recent Workspaces List opens the Workspace that is selected from this list

Exit exits the application and prompts for saving changes
16 33004243 05/2012



Edit Menu

In addition to the commands available in the Advantys Configuration Tool, the 
Advantys Configuration Software offers the Revert option on the Edit menu. Issuing 
this command causes the Island configuration revert to the last saved state. 
Changes made after the last time the Island configuration was saved are lost and 
irrecoverable.

View Menu

Because Islands are displayed in the Workspace Browser, the Workspace Browser 
replaces the Island Browser. Accordingly, the Workspace Browser option replaces 
the Island Browser option on the View menu. Further, a Log Window option for 
displaying or hiding the Log Window is available.

Island Menu

The Island menu contains several additional functions. Some of them are only 
available for STB and/or OTB modules.

The Island menu commands provided by the Advantys Configuration Software are 
described in the table below:

Command Description

Add Rail adds a rail to the active Island if the primary one was deleted for any 
reason

Add Annotation adds an annotation to the active Island

Delete Annotation removes the selected annotation from the active Island

Replace NIM exchanges the NIM in an existing Island configuration (for STB and 
OTB only)

Add Module opens a submenu that allows the selection of a catalog or a functional 
family in the Catalog Browser from which modules are to be added to 
the active Island

Module Editor invokes the Module Editor for the selected module

Label Editor invokes the User Defined Label Editor (for STB only)

Reflex Editor invokes the Reflex Editor (for STB only)

Build validates the software configuration of the active Island (for STB only)

Lock locks or unlocks the configuration of the active Island

Resource Analysis displays or hides the resource utilization chart for the active Island (for 
STB and OTB only)

I/O Image Overview displays the data assignment in the I/O image of the NIM

Baud Rate Tuning selects the baud rate for the internal Island bus (for STB only)
33004243 05/2012 17



Online Menu

The Advantys Configuration Software offers a whole new menu containing 
commands for manipulating an Island in online mode. However, these commands 
are only available for the STB product family and partly for the OTB product family.

The Online menu commands provided by the Advantys Configuration Software are 
described in the table below:

Temperature Range selects the Island’s temperature range (for STB only)

Test Mode Settings selects the test mode settings (for STB only)

Island Properties displays the properties of the selected Island

Command Description

Command Description

Connect connects to a physical Island and enables animation

Disconnect disconnects from a physical Island and disables animation

Connection Settings defines connection parameters

Configuration Port 
Settings

invokes the Configuration Port Settings dialog box for 
changing the communication parameters of the NIM (for STB 
only)

Run switches the connected Island to run mode (for STB only)

Stop switches the connected Island to stop state (for STB only)

Reset switches the connected Island to reset state, i.e. clears input 
and output data and auto-addresses all modules on the Island 
bus (for STB only)

Download into the Island downloads the configuration of the logical Island currently 
active in the Island Editor into the connected physical Island

Upload from the Island uploads the configuration from the connected physical Island to 
the logical Island currently active in the Island Editor

Store to SIM Card copies the configuration in the connected Island from the RAM 
to the SIM card (for STB only)

Protect defines the protection mode and password for the connected 
Island (for STB only)

Force Auto-configuration forces auto-configuration in the connected Island with defaults 
(for STB only)

Test Mode activates or deactivates the test mode in the connected Island 
(for STB only)

I/O Image Animation provides a dynamic display of the I/O data image of the 
connected Island (for STB only)
18 33004243 05/2012



Options Menu

The Options menu contains an additional function related to the Workspace. You 
can select the Workspace Properties option to invoke the Workspace Properties 
dialog box.

Windows Menu

The Advantys Configuration Software offers additional options for arranging the 
Island Editor windows (because a Workspace can contain several Islands and more 
than 1 can be open at a time).

The additional Windows menu commands are described in the table below:

Help Menu

On the Help menu, the Advantys Configuration Softwares offers additionally the 
What’s This? option for displaying the context-sensitive help on the item which is 
clicked next.

Command Description

Maximize maximizes the Island Editor windows and puts the active 
Island Editor into the foreground

Minimize minimizes the Island Editor windows

Cascade cascades the Island Editor windows
33004243 05/2012 19



Shortcut Menu Entries

Introduction

The Advantys Configuration Software provides additional shortcut menu entries 
within the following areas of the Workspace window:

Workspace Browser
Island Editor
Log Window

Workspace Browser

This table lists the shortcut menu entries available within the Workspace Browser:

If you right-click the ... Then a shortcut menu is displayed containing:

Workspace label Add Island including the Add New Island and the Add 
Existing Island options
Properties

Island label Add Rail
Remove
Build
I/O Image Overview
Connect
Disconnect
Properties

rail label Cut
Copy
Paste
Delete

module label Cut
Copy
Paste
Delete
Module Editor
20 33004243 05/2012



Island Editor

This table lists the shortcut menu entries available within the Island Editor:

Log Window

This table lists the shortcut menu entries available within the Log Window:

If you right-click ... Then a shortcut menu is displayed containing:

a module Cut
Copy
Paste
Delete
Replace NIM (for STB and OTB NIMs only)
Module Editor

a segment (DIN rail) Cut
Copy
Paste
Delete

the Island Editor Add Annotation
Paste

If you right-click ... Then a shortcut menu is displayed containing:

the Log Window Save Log File
Clear
33004243 05/2012 21



Module Editor

Introduction

The FTB, FTM and OTB Module Editors have been adapted to the STB Module 
Editor. The Parameters tab contains the configuration parameters, which are 
displayed in a hierarchical tree view comprising master and slave parameters. The 
main difference is that the parameters of FTB, FTM and OTB modules are assigned 
to each single data item, displayed as superordinated. In contrast, parameters of 
STB modules are listed as superordinated and the data items are assigned to them. 
The STB Module Editor can also be used for mapping I/Os, whereas FTB, FTM and 
OTB I/Os are mapped using the I/O Image Overview function.

Module Editor for STB Modules

The table below describes the different tabs of the STB Module Editor and for which 
modules they are available:

Tab Description

General This read-only tab displays an illustration of the selected module and 
provides a brief hardware and functional description. It is available for all 
STB modules.

Parameters This tab displays the operating parameters of the selected module which 
are currently not mapped. It is accessible for all STB standard I/O modules.

Ethernet 
Parameters

This tab displays the Ethernet specific parameters of the selected module. 
It is only accessible for the STB NIP2311 Ethernet NIM.
In online mode, the parameters cannot be changed.

Ports This tab displays the actual operating values of certain port parameters.
It is only accessible in online mode for the

STB NIP2311 Ethernet NIM
STB NCO2212 CANopen NIM version 3.05 or later

I/O Image This tab displays the selected module’s I/O data that are currently mapped. 
It is accessible for all STB I/O modules.
In online mode, the live I/O data of the selected module are dynamically 
displayed.

Diagnostics This read-only tab displays any error message generated by the selected 
module. It is only accessible in online mode for STB NIMs and I/O modules.

Options This tab displays optional parameters for the current module. It is 
accessible for STB NIMs and I/O modules.

I/O Mapping This tab displays the I/O mapping for the current module. It is available for 
STB standard I/O modules.

Information This read-only tab displays device parameters in online mode. It is only 
available for ATV and Tesys U modules in online mode. 
22 33004243 05/2012



Functions for STB Modules

It is possible to
view general module information,
edit parameters in offline mode,
assign user-defined labels to parameters and I/O data in offline mode,
modify the I/O mapping in offline mode,
monitor I/O data and module diagnostics in online mode and
set I/O data when the Island is online and in test mode.

Module Editor for OTB, FTM and FTB Modules

The table below describes the different tabs of the OTB Module Editor and for which 
modules they are available:

Functions for OTB, FTM and FTB Modules

In offline mode, it is possible to
view general module information,
edit parameters and
assign user-defined labels to I/O data.

Tab Description

General This read-only tab displays an illustration of the selected module and 
provides a brief hardware and functional description. It is available for all 
OTB, FTM and FTB modules.

Parameters This tab displays all input data objects of the selected module including 
bit level information. It is available for all OTB and FTB modules as well 
as for all FTM modules except for FTM NIMs.

Counters This tab displays the configuration parameters for the counters of the 
NIMs. Therefore, it is only available for OTB NIMs.

Pulse Generator This tab displays the configuration parameters for the pulse generators 
of the NIMs. Therefore, it is only available for OTB NIMs.

Options This tab displays the global configuration parameters for accessing the 
registers of NIM running on a Modbus protocol-based upstream fieldbus 
network. It is available for the OTB Ethernet and Modbus NIMs, not for 
the OTB CANopen NIM. It is not available for FTM and FTB modules.
33004243 05/2012 23



I/O Image

Introduction

The Advantys Configuration Software allows to view and edit the I/O image layout 
of the NIM by using the I/O Image Overview function. Depending on the NIM and 
the fieldbus type, the I/O Image Overview dialog box contains up to 5 tabs providing 
different views and types of access to the I/O image.

I/O Image Overview for STB Modules

The table below describes the different tabs of the I/O Image Overview dialog box 
and for which STB modules they are available:

For STB modules, the I/O Image Overview function provides an overview of the 
input/output image. However, mapping the I/Os is performed in the I/O Mapping tab 
of the Module Editor of the corresponding module.

When the Island is online and in test mode, it is possible to write I/O data using the 
I/O Image Animation function.

Tab Description

Modbus Image This tab displays the I/O image layout of Islands that feature a Modbus 
register-oriented arrangement of I/O data. It is available for all STB 
Islands, regardless of the NIM.

Fieldbus Image This tab displays the I/O image layout of Islands with a network interface 
connecting to a fieldbus other than Modbus register-oriented. It is 
available for all STB Islands, except those containing Ethernet or Modbus 
Plus NIMs because it equals their Modbus view.

HMI <-> PLC This tab lists the HMI-to-PLC and PLC-to-HMI data items. It is available 
for STB Islands containing Ethernet, Ethernet/IP and Modbus Plus NIMs. 
For all other fieldbuses, these data are included in the Modbus and the 
fieldbus view. 

TxPDOs These tabs display the current process data objects (PDO) layout 
presented by the NIM on the upstream fieldbus. It is only available for STB 
Islands containing CANopen NIMs.

RxPDOs
24 33004243 05/2012



I/O Image Overview for FTB, FTM and OTB Modules

The table below describes the different tabs of the I/O Image Overview dialog box 
that are available for the CANopen NIMs of the FTB, FTM and OTB product families:

The table below describes the different tabs of the I/O Image Overview dialog box 
that are available for Ethernet and Modbus NIMs of the OTB product family:

Tab Description

TxPDOs These tabs display the current PDO layout presented by the NIM on 
the upstream fieldbus. You can use it for modifying the I/O mapping of 
your Island.

RxPDOs

PDO Configuration This tab is for configuring the transmission parameters of the PDO 
items.

Fieldbus Image This tab displays the I/O image layout of CANopen Islands.

Data Ranges This tab lists mandatory, manufacturer and optional objects.

Tab Description

Registers (read-only) These tabs display the read-only and writeable registers. You 
can use it for modifying the I/O mapping of your Island.Registers (writeable)

Fieldbus Image This tab displays the I/O image layout of Ethernet and 
Modbus Plus Islands (fieldbus view equals Modbus view).

Data Ranges This tab contains input, output, parameter and diagnostics 
registers and I/O modules status registers. Further, special 
function registers (RFC, RVFC, PLS/PWM) are included.
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Resource Analysis and Reflex Editor

Resource Analysis

For STB and OTB Islands, the Advantys Configuration Software includes a feature 
for monitoring an Island’s resource consumption. Using the Resource Analysis 
function, you can access a dialog box with 2 tabs displaying various bar graphs.

In this table, the functions of the different tabs are described:

You can access the Resource Analysis function in online and offline mode.

Reflex Editor

For STB Islands only, the Advantys Configuration Software offers the Reflex Editor 
for creating reflex actions. Reflex actions are small routines that perform dedicated 
logical functions directly on the Island bus. They allow output modules on the Island 
to act on data and drive field actuators directly, without requiring the intervention of 
the fieldbus master.

The following reflex action types are available:
boolean logic
integer compare
unsigned compare
counter
timer
analog latch
digital latch

You can access the Reflex Editor when the STB Island is offline and unlocked.

Tab Description

Power This tab provides a bar graph illustrating the consumption of 
the logic power and the field power for each module in the 
Island that acts as a provider of logic and/or field power.
The bars are updated dynamically, i.e. after each module 
update operation.

Configuration This tab includes a bar graph representing the current relative 
configuration sizes for the input and the output process 
images and for the total configuration. For STB Islands only, 
the sizes for the HMI-to-PLC and the PLC-to-HMI data 
images are displayed as well.
The bars are updated once when the function is selected.
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Example Application
Introduction

This chapter contains an example application used to explain how
Islands are created,
labels are assigned,
reflex actions are configured and
a connection between the logical and the physical Island is made and a 
configuration is loaded.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Creating an Island 28

Labeling Data Objects 30

Creating Reflex Actions 33

Loading the Island Configuration 35
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Creating an Island

Introduction

In this example, a Premium PLC is connected to an Advantys STB Island using the 
Profibus DP fieldbus protocol. 

The physical Island consists of the following modules:
STBNDP2212 Profibus network interface module
STBPDT3100 power distribution module
STBDDI3420 4-channel digital input module
STBDDO3410 4-channel digital output module
STBAVI1270 2-channel analog input module
STBAVO1250 2-channel analog output module
STBXMP1100 termination plate

The name of the Island shall be Island1. The name of the Workspace in which this 
Island resides shall be Workspace1.

Mounting the Physical Island

The modules must be mounted on the DIN rail in the same sequence as they are 
listed above. The DIN rail must be connected to a power supply providing 24 V.

For mounting the modules on the DIN rail, for proper embedding the Island within 
the Workspace and for proper cabling, see the Advantys STB System Planning and 
installation Guide (see Advantys STB, System Planning and Installation Guide).

Creating the logical Island consists of the following steps:
creating a new Workspace and a new Island
adding modules to the Island

Creating a New Workspace

Having started the Advantys Configuration Software, perform the following steps to 
create a new Island in a new Workspace:

Step Action

1 From the File menu, select New Workspace.
Result: The New Workspace dialog box is displayed.

2 In the Name: field of the Workspace File area, type Workspace1.

3 In the Name: field of the Island File area, type Island1.
Note: Some menu commands contain placeholders which are replaced by the name 
of the Island. The command for saving this Island, for example, would read 
Save Island1.

4 Click OK.
Result: A new Workspace screen is displayed containing the new Island, which is 
displayed in the Island Editor as an empty DIN rail.
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Adding Modules to the Island

To add modules to the new Island, perform the following steps:

Step Action

1 In the Catalog Browser, double-click the label of the STB Catalog to expand the 
subtree of this product family.

2 Double-click the label of the networking module group to expand its subtree.

3 Double-click the STBNDP2212 Profibus NIM.
Result: The NIM is displayed as first module on the DIN rail.

4 Double-click the label of the
power module group to expand its subtree and then double-click the 
STBPDT3100 module.
digital input module group to expand its subtree and then double-click the 
STBDDI3420 module.
digital output module group to expand its subtree and then double-click the 
STBDDO3410 module.
analog input module group to expand its subtree and then double-click the 
STBAVI1270 module.
analog output module group to expand its subtree and then double-click the 
STBAVO1250 module.
accessories module group to expand its subtree and then double-click the 
STBXMP1100 termination plate.

Result: The modules are displayed on the DIN rail to the right of the NIM in the 
sequence in which they have been selected.
Note: Adhere to the sequence. For a successful download of the configuration into 
the physical Island, the module sequences of the physical and the logical Island 
must match.

5 From the File menu, select Save Island1 to save the configuration.
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Labeling Data Objects

Introduction

The Advantys Configuration Software allows you to assign meaningful names not 
only to Workspaces, Islands and their segments, but also to module parameters and 
I/O data objects.

The names you assign either replace the generic names completely (as for 
Workspaces, Islands and segments) or are appended to the generic names (as for 
data objects).

Depending on the data object, the labels are edited and displayed as follows:

NOTE: The labels must not be duplicates and they must be compliant to the 
IEC61131 rules:

Only alphanumeric and underscore characters can be used.
The first character must be an alphabetic character.
Blanks and non-ASCII characters are not allowed.
The overall length of the label must not exceed 24 characters.

In the following, it is described how data objects are labeled.

Description of the Example Labels

In the example Island Island1, a module parameter and the output data objects of 
the digital output module shall get labels. Data objects and labels are listed below:

Labels for ... Are appended using the ...

module parameters Parameters tab in the Module Editor, which is also the only place 
where they are displayed.

I/O data objects I/O Image tab in the Module Editor. The labels are displayed in the
I/O Image and I/O Mapping tabs of the Module Editor.
I/O Image Overview and I/O Image Animation dialog boxes in 
the cell-related information, listed when a cell is selected.
User Defined Label column of the User Defined Label Editor.

Data Object Label

Fallback Mode (as superordinate parameter) Timeout

Fallback Mode, Channel 1 MainChannel

Output Data (as superordinate data item) Station1

Output Data, Channel 2 Engine

Output Data, Channel 3 FrontEngine
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Labeling the Module Parameter

Before you can perform the following steps to assign lables to a module parameter, 
make sure the Island is offline and unlocked:

Labeling the Output Data Objects

Having assigned labels to the module parameter, perform the following steps to 
assign the labels to the output data objects:

Step Action

1 Select the STBDDO3410 digital output module.

2 Open the Module Editor by right-clicking the module and selecting Module Editor 
from the shortcut menu.

3 Click the Parameters tab.

4 In the Data Item Name column, expand the Fallback Mode Settings tree by 
clicking the plus sign in the box left to the name.
Result: The tree expands to the Fallback Mode tree.

5 Expand the Fallback Mode tree by clicking the plus sign in the box left to the name.
Result: The 4 channels belonging to the fallback mode parameter are listed.

6 In the User Defined Label column, double-click the Fallback Mode row.

7 Type Timeout.

8 Press ENTER.

9 In the User Defined Label column, double-click the Channel 1 row.

10 Type MainChannel.

11 Press ENTER.

Step Action

1 In the Module Editor of the STBDDO3410 digital output module, which is still open, 
click the I/O Image tab.

2 In the Data Item Name column, expand the Output Data tree by clicking the plus 
sign in the box left to the name.
Result: The 4 channels belonging to the output are listed.

3 In the User Defined Label column, double-click the Output Data row.

4 Type Station1.

5 Press ENTER.

6 In the User Defined Label column, double-click the Channel 2 row.

7 Type Engine.

8 Click OK to save the label and close the Module Editor.
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The second method to assign the labels to the output data objects is given in the 
following steps:

Step Action

1 Open the Label Editor from the Island menu, or click the following icon on the 
Island toolbar: 

Result: The User Defined Label Editor is displayed. 

2 In the User Defined Label column, click the row Channel 3 [Output Data] of the 
STBDDO3410 digital output module.
NOTE: This is only possible if the Island is offline and unlocked.

3 Type FrontEngine.

4 Press ENTER, or click another cell of the output data object you want to assign the 
label. Continue until all the output data ojects you wanted to assign labels is 
complete.

5 Click Apply, to apply the assigned labels.
or
Click OK, to save and close the User Defined Label Editor.

NOTE: The assigned labels are neither applied nor saved if you have typed 
duplicate labels.
32 33004243 05/2012



Creating Reflex Actions

Introduction

For the present example Island, which is an STB Island, it is possible to create reflex 
actions.

In the following, the creation of a boolean logic reflex action is described.

Description of a Boolean Logic Reflex Action

The Advantys Configuration Software supports these 3 boolean logic action types:
2-input AND
3-input AND
2-input XOR

Boolean logic blocks require 2 types of inputs, an enable input and 2 or 3 operational 
inputs. All the inputs need to be digital (boolean) values from sources that you must 
specify in the Reflex Editor. These sources can be derived, for example, from 
another input module on the Island bus or from a constant value that you specify. 
The output from any of these action types is also a boolean value. It is mapped to 
the action module, which is always 1 of the output modules of the Island. The 
channel to which the output of the reflex action is mapped becomes dedicated to the 
reflex action and can no longer use data from the fieldbus master to update its field 
device. Furthermore, you have the possibilities to negate both the inputs and the 
output.

The truth table below shows the possible outputs of the 2-input AND operation:

Description of the Example Reflex Action

The example Island shall contain a 2-input AND reflex block with an enable input 
and 2 operational inputs from the following sources:

If input 1 is ... and input 2 is ... Then the output is ...

0 0 0

0 1 0

1 0 0

1 1 1

Input Function Source

Enable Input turns the block on or off the constant value always enabled

Operational Input 1 sends a boolean value to the 
block

channel 1 of module STBDDI3420

Operational Input 2 the constant value high
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The result of this reflex action shall be mapped to channel 4 of the digital output 
module of the example Island.

Creating a Boolean Logic Reflex Action

Before you can perform the following steps to create a reflex action, make sure the 
Island is offline and unlocked:

Outputs of the Created Reflex Action

The truth table below describes the input/output behavior of the 2-input AND 
operation configured above for the example Island Island1:

Step Action

1 From the Island menu, select Reflex Editor.
Result: The Reflex Editor dialog box is displayed.

2 Click the New button.
Result: The several list boxes are accessible.

3 From the Action group: list, select Boolean Logic as the reflex action group.

4 From the Action type: list, select 2-Input AND as the reflex action type.

5 From the Action module: list, select the digital output module STBDDO3410 as the 
reflex action module.
Note: The module you specify here is automatically displayed in the 
Physical output: list.

6 In the Enable: row, select Always Enabled from the Module list.
Note: The Channel list is disabled.

7 In the Input 1: row, select the STBDDI3420 module from the Module list and 
Channel 1 from the Channel list.

8 In the Input 2: row, select High - 1 from the Module list.
Note: The Channel list is disabled.

9 From the Physical output: lists, select Channel 4 for the STBDDO3410 output 
module.

10 Click the OK button.
Result: A number is automatically assigned to the reflex action and the Action no.: 
field is updated. The data of the reflex action are displayed in the table at the bottom.

11 Click Close to close the dialog box.

If input 1is ... and input 2 is ... Then the output is ...

0 1 0

1 1 1
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Loading the Island Configuration

Introduction

For any loading operation, the logical Island must be in online mode. A logical Island 
is considered online if it has been successfully connected to a physical Island that is 
under power and able to operate. As a precondition for an online connection, you 
must physically connect the programming panel running the configuration software 
with the configuration port of the NIM using a Modbus cable.

Connecting to the Physical Island

In the present example, the following steps are necessary to connect the logical 
Island to the physical one:

Downloading the Configuration

The Download command allows you to transfer a configuration file previously built 
in the Advantys Configuration Software to the connected physical Island. For a 
download, the physical Island must be in reset state. If this is not the case, a 
message box is displayed informing you that the Island is automatically set to reset 
state. During the download process, a progress bar is displayed, tracking the status 
of the download. The configuration file is downloaded into the NIM’s RAM and flash, 
where it can then be saved to a removable memory card.

Step Action

1 From the Online menu, select Connect.
Result: A build is performed automatically. The first time you establish a connection 
in a session, the Connection Settings dialog box is displayed. By default, Serial is 
selected in the Connection Type.

2 Select the port, the baud rate and the other connection settings that match those set 
on the physical port via which you want to connect.
Note: The Advantys Configuration Software also provides a feature that 
automatically searches for the correct connection settings.

3 Click OK in the Connection Settings dialog box.
Result: The software attempts to connect to the physical Island. If a configuration 
mismatch between the logical and physical Island occurs, a message box will be 
displayed.

4 Click Download to copy the configuration from the software to the physical Island.
Result: After the download, the configurations of the logical and the physical Island 
are identical and the connection is established.
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Glossary
A

Auto-Addressing
The assignment of an address to each Island bus I/O module and preferred device.

Auto-Configuration
The ability of Island modules to operate with predefined default parameters. A 
configuration of the Island bus based completely on the actual assembly of I/Os.

B

Basic Network Interface
A low-cost Advantys STB network interface module that supports up to 12 Advantys 
STB I/O modules. A basic NIM does not support the Advantys Configuration 
Software, reflex actions, nor the use of an HMI panel.

N

NIM
The NIM (network interface module) is the interface between an Island bus and the 
fieldbus network of which the Island is a part. A NIM enables all the I/O on the Island 
to be treated as a single node on the fieldbus. The NIM also provides 5 V of logic 
power to the Advantys STB I/O modules in the same segment as the NIM.
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Glossary
P

PDO
In CAN-based networks, PDOs (process data objects) are transmitted as 
unconfirmed broadcast messages or sent from a producer device to a consumer 
device. The transmit PDO from the producer device has a specific identifier that 
corresponds to the receive PDO of the consumer devices.

Preferred Module
An I/O module that functions as an auto-addressable node on an Advantys STB 
Island but is not in the same form factor as a standard Advantys STB I/O module 
and therefore does not fit in an I/O base. A preferred device connects to the Island 
bus via an STB XBE 1100 EOS module and a length of STB XCA 100x bus 
extension cable. It can be extended to another preferred module or back into a 
standard Island segment. If it is the last device on the Island, it must be terminated 
with a 120 Ω terminator.

Premium Network Interface
An Advantys STB network interface module designed at a relatively high cost to 
support high module densities, high transport data capacity (for instance for web 
servers), and more diagnostics on the Island bus.

Process Image
A part of the NIM firmware that serves as a real-time data area for the data exchange 
process. The process image includes an input buffer that contains current data and 
status information from the Island bus and an output buffer that contains the current 
outputs for the Island bus, from the fieldbus master.
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Glossary
S

Segment
A group of interconnected I/O and power modules on an STB Island bus. An Island 
must have at least 1 segment and, depending on the type of NIM used, may have 
as many as 7 segments. The first (leftmost) module in a segment needs to provide 
logic power and Island bus communications to the I/O modules on its right. In the 
primary or basic segment, that function is filled by a NIM. In an extension segment, 
that function is filled by an STB XBE 1200 or an STB XBE 1300 BOS module. 

Standard Network Interface
An Advantys STB network interface module designed at moderate cost to support 
the configuration capabilities, multi-segment design and throughput capacity 
suitable for most standard applications on the Island bus. An Island run by a 
standard NIM can support up to 32 addressable Advantys STB and/or preferred I/O 
modules, up to 12 of which may be standard CANopen devices.
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A
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B
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C
CANopen, 11
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D
DeviceNet, 11
download, 35

E
Edit menu, 17
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Module Editor, 23
FTM modules
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